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AccVerify/AccRepair DS2 

Publisher 
HiSoftware Incorporated 
6 Chenell Drive Suite 280 
Concord, NH 03301 
USA 
Toll-Free: 888-272-2484 
Technical Support: 603-229-3055 
http://www.hisoftware.com
 

Retail Cost 
Depends on version.  AccVerify ($495.00), AccRepair ($995.00).  Prices as identified via 
website.  California Community College faculty and staff computers are covered under 
license through HTCTU (see the HTCTU for more information). 
 

System Requirements 
1.  A PC-based computer running Windows 95/98/Me/2000/XP.  Internet Explorer also 

recommended. 
 
2.  Recommended 64 MB RAM or greater. 
 
3.  25 MB of Hard Disk space.  Additional memory necessary for saving data sets. 
 
4.  AccVerify for FrontPage requires FrontPage to be pre-installed. 

 

Description 
AccVerify/AccRepair DS2 is combined application that provides web content developers 
with the ability to assess, review, and repair web content for accessibility and usability 
errors.  The AccVerify component of the AccVerify/AccRepair application can evaluate 
web pages stored on the local desktop or "live" content published to a webserver and report 
on accessibility and usability violations.  The AccRepair component can then assist a web 
author with repairing the web page to improve the overall accessibility of the web page 
(Note:  the repair function does not make corrections to web pages evaluated directly from 
the Web). 
 
Additional plug-ins are available from the HiSoftware website depending on your license 
agreement.  These additional tools can increase the functionality of MS Office documents 
delivered via the Web as well as validating hyperlinks and creating accessible HTML-
based forms. 
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Getting Started 
Install the AccVerify/AccRepair desktop application on a PC-based computer.  The 
application may install as AccVerify Professional – it is the same application (just a 
different name).  Once you have installed the application, you will need to enter the license 
key code that unlocks the features of the application (see below).  Once you have entered 
the license key, you should register the application at the HiSoftware website: 
(http://www.hisoftware.com/register.htm). 
 
AccVerify Setup Wizard 
After beginning the application, you may be asked several questions that determine how 
the AccVerify/AccRepair application will be configured for your use - these settings can 
be changed later if necessary.  For general use of AccVerify/AccRepair, select the 
following radio button options: 

1.  Choose the "Section 508 Report Mode (US Only) 
 
2.  Choose "Summary Only (Graphs are generated for summary reports) 
 
3.  Choose "AccVerify Project Mode – Off" 

 
When you have finished the Wizard, select the Finish button.  These settings can be 
changed by selecting Run from the File menu and choosing the Setup Wizard option. 
 
Installing the License Key 

1.  Select File from the menu bar. 
 
2.  Select Run. 
 
3.  Select License Manager…. 
 
4.  Press the Add button or select Add Product License from the File menu. 
 
5.  Enter the correct Company Name and License Key code.  Incorrectly entering this 

information will not validate the application and you will only be able to evaluate a 
set number of files. 

 
6.  Select OK and return to the application. 

 

Running Verifications 
AccVerify/AccRepair provides the ability to run two different types of verifications on the 
Web content you have identified, crawled, or browsed.  By simply running verification on 
the selected files, AccVerify/AccRepair will identify the pages with accessibility violations 
and provide a summary report.  This is an instantaneous "snapshot" of the accessibility of 
the current set of pages. 
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It is also possible to create report groups such that an entire Web accessibility evaluation 
can be archived for later review or shared among users.  Performing an evaluation as a 
report group allows for immediate verification, but also the ability to save the evaluation 
for review by accessibility team members. 
 
A third option is to perform a verification immediately followed by a repair of the web 
accessibility errors.  When operating in this fashion, AccVerify/AccRepair will first assess 
the web accessibility of a page followed by a prompt asking the user if they wish to run the 
AccRepair Wizard (see the section Using the AccRepair Wizard for more information 
about this tool).  It is possible to select the Verification Only mode in order to only 
perform an evaluation on the web content and not be prompted for the AccRepair Wizard 
at each step. 
 
Verify All Option 
The Verify All option allows you to evaluate the web content you identified.  This is a 
"snapshot" of the accessibility of the site and is not retained for later use.  Select Verify 
from the menu bar and choose "Verify All". 
 
Verify All As Report Group Option 
The Verify All as Report Group option provides the opportunity to save a report for later 
viewing or to send the report to another individual.  The resulting report is viewable using 
a web browser.  Select Verify from the menu bar and select "Verify All as Report Group".  
You will then be asked to specify a name for this report group.  Report groups can be 
accessed from Reports Distribution Utility option – see this section later in the manual. 
 
Enable/Disable Verification Only Mode 
To enable or disable the Verification Mode of AccVerify/AccRepair, select Settings from 
the menu bar and choose "AccRepair Settings…".  To only evaluate content, make sure the 
Verification Only Mode checkbox is checked.  If you wish to evaluate AND repair content, 
uncheck this checkbox. 
 

 
 

Evaluating Web Content 
AccVerify/AccRepair will allow you to evaluate a web page individually, a group of web 
pages, or spider a website and report the accessibility and usability violations of the 
scanned files.  Depending on your need, you may find it easier to scan one web page at a 
time or perform a review of a set of web pages.  In order to manage your workflow and 
time investment, it is recommended to focus your efforts on a select group of web pages. 
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Evaluating a Single Web Page 
1.  Select File from the menu bar and choose Select File or File List. 
 
2.  If the "View/Edit File" button is selected, then you will see the Source Code of the 

file you chose in the upper pane and the accessibility violations in the lower pane.  
If you make changes to the source code directly, make sure to select the Save File 
button in the lower right corner. 

 
3.  To evaluate the web page, select the "View Reports" button and choose Verify.  This 

will produce an evaluation report on the accessibility errors contained on the web 
page.  Content will then be identified whether it Passes (Yes), Fails (No), or is Not 
Assessed (N/A).  Content that does not pass will be identified by the line number in 
the HTML code where the violation occurs. 

 
4.  Select the "Files / Preview" button to manually assess the usability of the web page.  

Choose the desired file from the lower pane and press the Preview button (you may 
also select the Auto Preview checkbox if you want to view the web page when you 
select the desired file).  See the information below regarding the different preview 
modes. 

 
Evaluating a Group of Web Pages 

1.  Select File from the menu bar and choose Scan Folders. 
 
2.  Identify the folder containing the web pages.  If you have subfolders with additional 

web page content, make sure to check the Include Subfolders checkbox.  Press 
Start to begin the scan. 

 
3.  The list of files will appear in the Files/Preview view.  To run a verification, press 

the Verify button just below the menu bar (or select Verify from the menu bar and 
choose Verify All).  You may be prompted to Run the AccRepair Wizard – only 
run this wizard if you wish to repair the files in question before completing the 
analysis.  If you wish to only analyze the files, select the Run in Verification Only 
mode checkbox and select No. 

 
4.  AccVerify will shift to the View Reports mode to view a summary of the 

accessibility review of the scanned web folder.  Files that do not pass will be listed 
under the Failed Files heading in the left frame.  Select the file and review the 
accessibility report for information regarding potential web accessibility violations. 

 
5.  Select the View button in the lower right if you wish to view the report in a HTML 

format. 
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Evaluating a Live Web Page 
1.  Select File from the menu bar and choose Select from the Web. 
 
2.  Enter the URL of the web page you wish to analyze.  Be sure to enter the http:// . 
 
3.  Select the specific file under the Selected Files in the "Files / Preview" view.  If the 

AutoPreview checkbox is selected, you will see a representation of the page. 
 
4.  When AutoPreviewing a web page, you will not be able to view the actual images or 

enable/disable stylesheet elements. 
 
5.  To run a verification, press the Verify button just below the menu bar (or select 

Verify from the menu bar and choose Verify All). 
 
6.  AccVerify will shift to the View Reports mode to view a summary of the 

accessibility review of the scanned web folder.  Files that do not pass will be listed 
under the Failed Files heading in the left frame.  Select the file and review the 
accessibility report for information regarding potential web accessibility violations.  
Select the View button in the lower right if you wish to view the report in a HTML 
format. 

 
Evaluating a Website - Manual 
To be performed when you want to gather specific live files in a website. 
 

 
 

1.  Select File from the menu bar and choose Browse and Select from the Web. 
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2.  Enter the domain of the website (e.g., http://www.htctu.net) and the name of the start 
file (e.g., index.htm, etc.).  Open the list box to select from a variety of start files 
names. 

 
3.  Select Browse Now to gather all the information currently hosted on the webserver.  

You will need to select the plus symbol (+) next to each URL in order to have this 
file selected for verification.  Once you have selected the content, close the dialog 
window and all the files will appear in the "Files / Preview" window. 

 
4.  To run a verification, press the Verify button just below the menu bar (or select 

Verify from the menu bar and choose Verify All). 
 
5.  AccVerify will shift to the View Reports mode to view a summary of the 

accessibility review of the scanned web folder.  Files that do not pass will be listed 
under the Failed Files heading in the left frame.  Select the file and review the 
accessibility report for information regarding potential web accessibility violations.  
Select the View button in the lower right if you wish to view the report in a HTML 
format. 

 
Evaluating a Website - Automatic 
To be used if you wish to restrict the evaluation process to only a set of Web pages within 
a Website. 
 

 
 

1.  Select File from the menu bar and choose Automated Web Browse Select. 
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2.  Enter the domain of the website (e.g., http://www.htctu.net) and the name of the start 

file (e.g., index.htm, etc.).  Open the list box to select from a variety of start files 
names. 

 
3.  If there a need to "Log In" to the web page, enter the appropriate username and 

password for HTTP authentication. 
 
4.  Choose your Browse Options to determine how you wish the crawler to search your 

site.  Recommended options are: Host Only, Treat Links without Extensions as 
Directories, and Ignore Dynamic Links.  If you wish to remain within the directory 
you are evaluating, then check Crawl as a Virtual Sub-Domain.  (In other words, 
you will crawl only within the /divisions sub-directory and not any pages outside of 
this directory if you set your domain to www.htctu.net/divisions ). 

 
5.  Identify the total number of levels you wish to crawl.  Level 1 would be the 

homepage and all links from the home page.  Level 2 would be the homepage, those 
pages linked to the homepage, and those pages linked to the first set of pages from 
the homepage. 

 
6.  Use Exclude Directories tab to identify specific directories that you do not wish to be 

crawled and analyzed.  Enter as /directory/ (forward slash directory name) in order 
to exclude a particular directory.  You can also download the "robots.txt" file (tells 
search engines which specific directories to ignore) in order to exclude these sub-
directories as well. 

 
7.  Press Start when you are ready to begin.  AccVerify will begin crawling the pages.  

When it has completed, press the Close button in the Running Automated Browse 
window. 

 

 
 
8.  You may now run a verification to analyze the crawled information. 

 

Performing Repairs 
AccVerify/AccRepair provides web authors with the capability to make repairs to the 
content that is identifies as inaccessible.  In some cases, the necessary "repair" has already 
been completed and added to the AccRepair Library.  This can improve the speed at which 
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simple repairs can be made to web content (e.g., adding the same alternative text 
throughout a website, etc.).  Repairing content is possible when performing a validation on 
the selected web content.  It is necessary to turn on the repair functionality before running 
the validation. 
 
Enable AccRepair Wizard 
When turning on the AccRepair Wizard, you are essentially disabling the Verification 
Mode of AccVerify/AccRepair.  To turn on the AccRepair Wizard, select Settings from 
the menu bar and choose "AccRepair Settings…".  Uncheck the checkbox marked 
"Verification Only Mode" and save your settings.  This will launch the AccRepair Wizard 
the next time the selected web content is evaluated. 
 
Starting the AccRepair Wizard 
To start the AccRepair Wizard, follow the steps on the previous pages to select the desired 
web information.  When you begin to run the verification, you will receive a prompt that 
asks if you wish to run the AccRepair Wizard.  Select Yes to run the AccRepair Wizard. 
 

 
 
The AccRepair Wizard will prompt the user through the repair of web content based on the 
accessibility violations encountered. 
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The AccRepair Wizard identified two elements that did not pass the accessibility review 
according to the US Section 508 Standards.  These two violations would be fixed by 
proceeding through the AccRepair Wizard.  Make sure the Automatically fix errors using 
the AccRepair Library checkbox is checked to automatically repair the same errors. 
 
Repairing Images 
AccVerify/AccRepair can decrease the time required to make images more accessible to 
assistive computer technology by prompting a web author for the appropriate alternative 
text and, if necessary, long description information.  When using images as "spacer" 
images for layout purposes, it is still necessary to enter an alternative text tag.  Assistive 
computer technology will recognize that these "blank" images are used for layout purposes 
and will avoid reading the information to the user.  To use a "blank" alternative text value, 
enter the word null into the Alternate Text field. 
 

1.  Select the web content you wish to evaluate. 
 
2.  Run verification on the selected content and choose to begin the AccRepair Wizard. 
 
3.  When AccRepair encounters an image with missing alternative text, it will prompt 

the user for the necessary information (i.e., alt-text and long description). 
 
4.  Enter the necessary information and press OK. 
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Repairing Tables 
Using AccVerify/AccRepair, we authors can make changes to layout and data tables to 
improve the accessibility of the content.  According to the Section 508 Standards 
(1194.22), only data tables are required to contain specific markup to make the data tables 
accessible to assistive computer technology.  This markup includes the use of either the 
Scope tags or ID and Header tags.  Including a Summary tag can also improve the meaning 
and comprehension of the table. 
 

1.  Select the web content you wish to evaluate and run verification on the selected 
content.  The AccRepair Wizard will not automatically check for tables.  However, 
it is necessary to run the verification in order to the program to detect the presence 
of tables. 

 
2.  Select Tools from the menu bar and choose "Table Repair Utility". 
 
3.  The Table Utility Editor will identify both layout and data tables in all the web pages 

that were verified.  Use the "Table Preview" button at the top of the Editor to 
identify if the table is used for layout or for data. 
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4.  If the detected table is a data table, you will need to switch to the "Table Grid View" 

to identify the correct row and column headers. 
5.  Check the checkbox marked "Make all cells in these row(s) Table Header (TH) 

cells" and identify the appropriate row number.  Also check the checkbox marked 
"Add scope attribute to Table Header cells". 
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6.  You can also easily change the scope tag using the "Scope, Headers, and Axis" 

button.  Select the "Scope Wizard" and identify the appropriate row and column 
cells in the Table Grid View.  Select Update to complete the Wizard. 

 
7.  Complete the data table information by selecting the "Type, Summary, and Caption" 

button and entering the summary and caption information (optional). 
 

 
 
8.  Press Finish to save the changes to the table. 

 
 
Repairing Forms 
Forms can provide a variety of uses on web pages and most interactive websites have some 
type of form element present (e.g., Search fields, etc.).  Forms can be difficult for some 
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types of assistive computer technology in that the user must interact with the form using 
two different interactive methods.  Usually this requires a user to read the web page and 
then enter a "forms mode" in order to enter data.  However, when in the "forms mode", the 
user does not have the capability to read the rest of the web page. 
 
Adding specific HTML content to the form input fields and the associated screen text can 
greatly improve the user experience.  It is necessary to manually start the repair process for 
forms when using the AccVerify/AccRepair application. 
 

1.  Select the web content you wish to evaluate and run verification on the selected 
content.  The AccRepair Wizard will not automatically repair forms.  However, it is 
necessary to run the verification in order to the program to detect the presence of 
forms. 

 
2.  Select Tools from the menu bar and choose "Form Repair Utility". 
 
3.  The Form Utility Editor will launch and allow the web author to make the necessary 

changes to the form fields.  Identify the field name in the list of form fields and 
select the "Field Label" button. 
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4.  Highlight the appropriate text content that you wish to be associated with the form 
field identified in step 3. 

 

 
 
5.  Press the "Set Label" button to input the correct <label> tag attribute.  Notice the 

additional HTML code that is inserted into the source code window. 
 

 
 
6.  Select the "Field Properties" button to add information about the tabindex and access 

key values.  You may also add alternative text to improve the user experience with 
some types of assistive computer technology. 

 

 
 
7.  Return to the "Form Fields" button and add the necessary information for another 

form field.  Press Finish to save the changes and move to another form. 
 

The Preview Options 
The Preview Options are several buttons that allows a developer to quickly assess the use 
of images, colors, stylesheets as well as page linearization.  A brief review of each function 
is identified below.  Each function may be activated using the mouse or keyboard. 
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Images 
The Images toggle allows the user to view the web page with the images enabled or 
disabled.  Images that contain alternate-text will display the alternate text when the image 
function is enabled.  If you are previewing a web page that is currently live (as opposed to 
content on the local system), you will not see the images in the Preview pane.  Section 508 
– 1194.22 (a) and Priority 1 requirement. 
 
Styles 
The Styles toggle enables or disables the stylesheets of the current web page.  It is 
important that the information contained on a web page can be read if the stylesheets are 
disabled.  If you are previewing a web page that is currently live, (as opposed to content on 
the local system), the web page will automatically disable the stylesheets.  Section 508 – 
1194.22 (d) and Priority 1 requirement. 
 
Linearize 
The Linearize toggle allows web page developers to view the reading order/logical flow of 
information on their web page.  Layout tables are removed from the web page and the 
content is left-justified on the screen.  The Linearize view is very similar to how some 
types of assistive computer technology will read the information; evaluating the linearized 
content can give developers a sense of how the web page will be presented to different 
users.  Priority 2 requirement. 
 
Colors 
The Colors function takes the current web page and opens a new browser window with the 
web page presented in grayscale.  It is important that color alone is not used to convey 
information and this function allows developers to view their web pages with color 
disabled.  Section 508 – 1194.22 (c) and Priority 1 requirement. 
 

Report Distribution Utility 
The Report Distribution Utility allows the user to export any reports that have been 
verified to be exported as a fully linked HTML file.  This allows the reviewer to send the 
report to any individual who wishes to assess the verification report and may not have the 
AccVerify/AccRepair program.  Additionally, the report is exported in a .zip file format, 
making the report very portable. 
 

1.  Select Reports from the menu bar, and choose Report Distribution Utility. 
 
2.  Identify the appropriate report group from the list on the left part of the screen.  Press 

the Next button. 
 
3.  Specify a location for the report file on the local computer.  This can be on the 

desktop or other location.  The Report Distribution Utility will append the file 
extension ".zip" to the end of the name you specify. 
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4.  Press the Finish button.  This will create a report as a zip file that contains the entire 

evaluation in a HTML format.  The zip file may be then e-mailed or archived for 
later use. 

 
5.  To review the report, simply unzip the information and select the file 

Report_fndx.htm to navigate the HTML content.  The entire report may be 
reviewed by other individuals who do not have the AccVerify/AccRepair 
application installed. 

 
6.  The Report Distribution Utility can also password protect the files, if necessary, for 

security purposes as well as e-mail the information to the desired user.  Please view 
the Help menu in the Report Distribution Utility for more information about these 
features. 
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The AccRepair Library 
The AccRepair Library provides a tool for developer to improve website accessibility 
changes if they already are aware of the inaccessible content.  In other words, if the use of 
"spacer" images is used throughout the site, then it is possible to introduce the correct 
changes into the AccRepair Library before beginning an evaluation process.  This provides 
the opportunity to "pre-load" the automatic fixes to speed the retrofit of content. 
 
The AccRepair Library will accept fixes that reflect Images, Form Fields, Image Map 
Links, HTML Objects, and Applets.  For each type of HTML information, you will need to 
know the specific attributes for each particular instance of code.  This section will review 
the issues surrounding Images as this is the most likely scenario on large websites. 
It is important to note that the AccRepair Library does not go out and "replace" alternative 
text for images that already contain this attribute.  This would be necessary using a HTML 
authoring tool.  Additionally, it is still necessary to run the AccVerify evaluation process 
and choose to use the AccRepair Wizard. 
 

1.  Go to the Start menu and choose the HiSoftware AccVerify menu and then choose 
the Tools menu.  Select AccRepair Library. 

 
2.  To "pre-load" image information, select Add in the lower left of the application. 
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3.  Identify the path of the file name in the Image File Name field.  Enter the 
appropriate amount of alternative text for the image in the Alternative Text field.  
If the image requires a longer description, enter the file name of the long description 
tag in the Long Description field. 

 
4.  Press Save to save the information to the AccRepair Library. 

 

 
 
 
The appropriate information has now been entered into the AccRepair Library.  When the 
web content to be evaluated is assessed and the AccRepair Wizard started, the data in the 
AccRepair Library will automatically repair the HTML violations. 
 

Customizing AccVerify Reports 
In addition to making repairs to Web-based materials, the AccVerify application can be set 
to simply perform automated evaluations of Web content and not perform any repairs.  
Upon performing the default installation of AccVerify/AccRepair, you will be prompted to 
specify either the US Section 508 Standards or World Wide Web Consortium (W3C) Web 
Content Accessibility Guidelines as evaluation checkpoints.  These evaluation checkpoints 
contain the technical language originally developed by the respective entity as explanations 
as to why the Web page(s) may have failed - or passed - the automated verification 
process.  Additionally, the AccVerify/AccRepair application defaults to providing the 
complete report to the user specifying content that passed, failed, or necessitates a manual 
evaluation of the content. 
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Some users, however, may not benefit from receiving evaluations in which the entire 
report is presented.  Some users may not benefit from having the report present the 
technical language as to why the Web page did not pass a particular evaluation checkpoint.  
It is possible to customize the report interface such that the technical language is replaced 
with a simpler explanation of the error or to remove checkpoints that may not pertain to the 
page. 
 
Customizing the Checkpoint Language 
By customizing the checkpoint language, you can provide improved feedback for the 
checkpoint explanations.  This may be important if working with evaluators who are not 
familiar with the technical language of the evaluation criteria. 
 

1.  Select "Settings" from the menu bar and choose "Report Settings". 
 
2.  Select the "Advanced" tab on the right side of the Report Settings window.  Press the 

"Customize Report Text" button. 
 
3.  Choose either the W3C Report Mode or Section 508 Report Mode tab. 
 
4.  In the left frame, open the folders to view the specific checkpoints.  The default 

checkpoint text is located in the upper right frame and the customizable checkpoint 
text is located in the lower right frame. 

 
5.  Change the text in the lower right frame to accommodate your needs.  Make sure to 

select the "Save" button in order to save your changes. 
 
6.  If you wish to reset the checkpoint text to the default text, select the "Use Default" 

button.  If you wish to reset the checkpoint text for ALL the checkpoints, select the 
"Reset All" button. 

 
Customizing the Report Content 
The AccVerify Report can be modified to include (or remove) specific details that may not 
pertain to your evaluation workflow.  For instance, you may not wish to view all the 
Manual Checks when performing an evaluation if you perform Manual Checks at a 
separate point in your Web page evaluation process. 
 

1.  Select "Settings" from the menu bar and choose "Report Settings". 
 
2.  Select the "Report Detail" tab in the middle of the Report Settings window. 
 
3.  Under the Report Detail Options, choose the radio button "Show only checkpoints 

that have a failure or warning result".  This will remove Manual Checks from the 
AccVerify Report. 
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4.  Under the Checkpoint Detail, choose the radio button "Show only the detail items I 
select in the report" in order to view specific report content.  Use the checkboxes to 
enable/disable the content you wish to include in your AccVerify Report. 

 
5.  Press "Save" in order to save your settings.  The next time a report is run, you will 

have a different AccVerify Report view. 
 

The Help Menu 
A feature in the AccVerify/AccRepair program is the ability to view Help information 
about the specific topic or screen you are currently viewing.  This context-specific help can 
make it easier to review the necessary information specific to the current task.  The Help 
menu is primarily text delivered in an HTML format.  To view the Help information in any 
of the current tasks, simply press F1 or select the Help button. 
 

Other Tools 
The AccVerify/AccRepair application may also contain additional tools depending on the 
version that was purchased.  For the most part, these tools are designed to improve the 
usability of HTML content by incorporating tools to create valid HTML information or by 
assessing link integrity, etc.  For more information about the specific tools, please view the 
Help menu information within these applications. 
 
TagGen 
TagGen generates and supports developers by prompting for the appropriate HTML 
content that can identify a page on the Web.  This includes keywords, metadata content, 
language settings, document author, etc.  For more information about TagGen, please 
review the Help menu information within the application or visit: 
http://www.hisoftware.com/Tent.htm
 
Link Validation Utility 
The Link Validation Utility can identify hyperlinks that are invalid as well as the type of 
content that the hyperlink refers to on the Web.  A primary function of the tool is to alert 
developers to invalid hyperlink targets and report back the functionality of the content.  For 
more information please review the Help menu within the application, or visit: 
http://www.hisoftware.com/linkvalidate/index.html
 
Hi-Caption 
Hi-Caption is a separate tool that provides for the synchronization and formatting of 
captioning for multimedia presentations.  Hi-Caption can export SAMI, SMIL, and 
SMIL/QuickTime text formats for additional processing.  For more information, please 
visit: http://www.hisoftware.com/hmcc/index.html
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Federal Accessibility Standards for Web-based 
Intranet and Internet Information and Applications 

(Provided by www.usability.gov) 
 
This page contains excerpts from Electronic and Information Technology Accessibility 
Standards issued by the ARCHITECTURAL AND TRANSPORTATION BARRIERS 
COMPLIANCE BOARD. 
 
Shown below are:  
Paragraphs from the Overview of the Standards  
Subpart B — Technical Standards: Sec. 1194.22 Web-based intranet and internet 
information and applications.  
 
This page only contains an excerpt of the summary and standards that directly relate to 
Web sites. Other parts of the standard may apply to your situation. See the complete, 
officially posted standards at http://www.access-board.gov/news/508-final.htm.  
 
Electronic and Information Technology Accessibility Standards  
ARCHITECTURAL AND TRANSPORTATION BARRIERS COMPLIANCE BOARD 
[Published in the Federal Register on December 21, 2000]  
 

Summary: 
Web-based Intranet and Internet Information and Applications (1194.22)  
The criteria for web-based technology and information are based on access guidelines 
developed by the Web Accessibility Initiative of the World Wide Web Consortium. Many 
of these provisions ensure access for people with vision impairments who rely on various 
assistive products to access computer-based information, such as screen readers, which 
translate what's on a computer screen into automated audible output, and refreshable 
Braille displays. Certain conventions, such as verbal tags or identification of graphics and 
format devices, like frames, are necessary so that these devices can "read" them for the 
user in a sensible way. The standards do not prohibit the use of web site graphics or 
animation. Instead, the standards aim to ensure that such information is also available in an 
accessible format. Generally, this means use of text labels or descriptors for graphics and 
certain format elements. (HTML code already provides an "Alt Text" tag for graphics 
which can serve as a verbal descriptor for graphics). This section also addresses the 
usability of multimedia presentations, image maps, style sheets, scripting languages, 
applets and plug-ins, and electronic forms.  
 
The standards apply to Federal web sites but not to private sector web sites (unless a site is 
provided under contract to a Federal agency, in which case only that web site or portion 
covered by the contract would have to comply). Accessible sites offer significant 
advantages that go beyond access. For example, those with "text-only" options provide a 
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faster downloading alternative and can facilitate transmission of web-based data to cell 
phones and personal digital assistants.  
 
§ 1194.22 Web-based intranet and internet information and applications. 
(a) A text equivalent for every non-text element shall be provided (e.g., via "alt", 
"longdesc", or in element content). 
 
(b) Equivalent alternatives for any multimedia presentation shall be synchronized with the 
presentation. 
 
(c) Web pages shall be designed so that all information conveyed with color is also 
available without color, for example from context or markup. 
 
(d) Documents shall be organized so they are readable without requiring an associated 
style sheet. 
 
(e) Redundant text links shall be provided for each active region of a server-side image 
map. 
 
(f) Client-side image maps shall be provided instead of server-side image maps except 
where the regions cannot be defined with an available geometric shape. 
 
(g) Row and column headers shall be identified for data tables. 
 
(h) Markup shall be used to associate data cells and header cells for data tables that have 
two or more logical levels of row or column headers. 
 
(i) Frames shall be titled with text that facilitates frame identification and navigation. 
 
(j) Pages shall be designed to avoid causing the screen to flicker with a frequency greater 
than 2 Hz and lower than 55 Hz. 
 
(k) A text-only page, with equivalent information or functionality, shall be provided to 
make a web site comply with the provisions of this part, when compliance cannot be 
accomplished in any other way. The content of the text-only page shall be updated 
whenever the primary page changes. 
 
(l) When pages utilize scripting languages to display content, or to create interface 
elements, the information provided by the script shall be identified with functional text that 
can be read by assistive technology. 
 
(m) When a web page requires that an applet, plug-in or other application be present on the 
client system to interpret page content, the page must provide a link to a plug-in or applet 
that complies with §1194.21(a) through (l). 
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(n) When electronic forms are designed to be completed on-line, the form shall allow 
people using assistive technology to access the information, field elements, and 
functionality required for completion and submission of the form, including all directions 
and cues. 
 
(o) A method shall be provided that permits users to skip repetitive navigation links. 
 
(p) When a timed response is required, the user shall be alerted and given sufficient time to 
indicate more time is required. 
 
Note to §1194.22:  

1.  The Board interprets paragraphs (a) through (k) of this section as consistent 
with the following priority 1 Checkpoints of the Web Content Accessibility 
Guidelines 1.0 (WCAG 1.0) (May 5, 1999) published by the Web Accessibility 
Initiative of the World Wide Web Consortium:  

 
Section 1194.22 
Paragraph 
(a) 
(b) 
(c) 
(d) 
(e) 
(f) 
(g) 
(h) 
(i) 
(j) 
(k) 

WCAG 1.0 
Checkpoint 
1.1 
1.4 
2.1 
6.1 
1.2 
9.1 
5.1 
5.2 
12.1 
7.1 
11.4 

  
2.  Paragraphs (l), (m), (n), (o), and (p) of this section are different from WCAG 1.0. Web 
pages that conform to WCAG 1.0, level A (i.e., all priority 1 checkpoints) must also meet 
paragraphs (l), (m), (n), (o), and (p) of this section to comply with this section. WCAG 1.0 
is available at http://www.w3.org/TR/1999/WAI-WEBCONTENT-19990505. 
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Web Content Accessibility Guidelines (WCAG) 1.0 

Introduction 
The Web Content Accessibility Guidelines (WCAG), version 1.0, is a set of guidelines 
designed to assist web developers in designing and creating universally accessible 
websites.  These guidelines were developed by the Web Accessibility Initiative (WAI), a 
subgroup of the World Wide Web Consortium (W3C).  The guidelines for accessible web 
design are separated into various checkpoints that are assigned priority levels.  The priority 
levels are as follows: 
 
Priority 1: 

A Web content developer must satisfy this checkpoint. Otherwise, one or more 
groups will find it impossible to access information in the document. Satisfying 
this checkpoint is a basic requirement for some groups to be able to use Web 
documents. 

 
Priority 2: 

A Web content developer should satisfy this checkpoint. Otherwise, one or 
more groups will find it difficult to access information in the document. 
Satisfying this checkpoint will remove significant barriers to accessing Web 
documents. 
 

Priority 3: 
A Web content developer may address this checkpoint. Otherwise, one or more 
groups will find it somewhat difficult to access information in the document. 
Satisfying this checkpoint will improve access to Web documents. 

 
The goal of these guidelines, as outlined by the WAI, is to encourage the development and 
implementation of accessible on-line content for all users, not just users requiring assistive 
technology.  Accroding to the WAI, the guidelines are "…not to discourage content 
developers from using images, video, etc., but rather explain how to make multimedia 
content more accessible to a wide audience." 
 
The following pages separate the WCAG 1.0 guidelines into the three priority levels 
established by the WAI along with the corresponding accessibility checkpoint. 

29 



WAI Priority 1 Checkpoints 

In General (Priority 1) 
• 1.1 Provide a text equivalent for every non-text element (e.g., 

via "alt", "longdesc", or in element content). This includes: 
images, graphical representations of text (including symbols), 
image map regions, animations (e.g., animated GIFs), applets 
and programmatic objects, ascii art, frames, scripts, images 
used as list bullets, spacers, graphical buttons, sounds (played 
with or without user interaction), stand-alone audio files, audio 
tracks of video, and video.  

• 2.1 Ensure that all information conveyed with color is also 
available without color, for example from context or markup.  

• 4.1 Clearly identify changes in the natural language of a 
document's text and any text equivalents (e.g., captions).  

• 6.1 Organize documents so they may be read without style 
sheets. For example, when an HTML document is rendered 
without associated style sheets, it must still be possible to read 
the document.  

• 6.2 Ensure that equivalents for dynamic content are updated 
when the dynamic content changes.  

• 7.1 Until user agents allow users to control flickering, avoid 
causing the screen to flicker.  

• 14.1 Use the clearest and simplest language appropriate for a 
site's content.  

And if you use images and image maps (Priority 1) 
• 1.2 Provide redundant text links for each active region of a 

server-side image map.  

• 9.1 Provide client-side image maps instead of server-side 
image maps except where the regions cannot be defined with 
an available geometric shape.  
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And if you use tables (Priority 1) 
• 5.1 For data tables, identify row and column headers.  

• 5.2 For data tables that have two or more logical levels of row 
or column headers, use markup to associate data cells and 
header cells.  

And if you use frames (Priority 1) 
• 12.1 Title each frame to facilitate frame identification and 

navigation.  
And if you use applets and scripts (Priority 1) 

• 6.3 Ensure that pages are usable when scripts, applets, or 
other programmatic objects are turned off or not supported. If 
this is not possible, provide equivalent information on an 
alternative accessible page.  

And if you use multimedia (Priority 1) 
• 1.3 Until user agents can automatically read aloud the text 

equivalent of a visual track, provide an auditory description of 
the important information of the visual track of a multimedia 
presentation.  

• 1.4 For any time-based multimedia presentation (e.g., a movie 
or animation), synchronize equivalent alternatives (e.g., 
captions or auditory descriptions of the visual track) with the 
presentation.  

And if all else fails (Priority 1) 
• 11.4 If, after best efforts, you cannot create an accessible page, 

provide a link to an alternative page that uses W3C technologies, 
is accessible, has equivalent information (or functionality), and is 
updated as often as the inaccessible (original) page. 
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Web Resources 

HiSoftware Tools 
AccVerify/AccRepair Application 
http://www.hisoftware.com/access/newvIndex.html
 
AccMonitor 
http://www.hisoftware.com/access/newmonitor.html
 
Hi-Caption 
http://www.hisoftware.com/hmcc/index.html
 
Accessibility Tool for Macromedia Flash 
http://www.hisoftware.com/macromedia_flash/
 
 

Standards and Guidelines 
Section 508 Standards 
http://www.section508.org
 
http://www.access-board.gov
 
Web-based Intranet and Internet Information and Applications – Section 1194.22 
http://www.access-board.gov/sec508/guide/1194.22.htm
 
W3C Web Accessibility Initiative (WAI) Guidelines 
http://www.w3c.org/WAI/
 
Usability.gov 
http://www.usability.gov
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